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Disclaimer: This document is intended to assist in the design and creation of accessible online content and documents. The guidelines reflect WCAG 2.2 A/AA criteria and other accessibility best practices but do not represent an official effort toward accessibility compliance. The guidelines herein are not exhaustive and will be updated periodically.
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[bookmark: _gjdgxs]Introduction to Accessibility
Accessibility means making sure that everyone can use products, services, and facilities on their own, regardless of abilities. This includes people with disabilities related to vision, hearing, movement, thinking, or speaking.
Many of us have had temporary challenges, like a broken arm or trying to see in dim light. These experiences show how important it is to consider diverse needs. In fact, about one in four adults in the U.S. have some form of disability.
Accessibility benefits everyone, not just those with disabilities. For example, ramps and curb cuts help wheelchair users but also parents with strollers and cyclists. Many common tools, like the typewriter and the telephone, were first created to help people with disabilities. Today, accessibility features, such as speech-to-text apps and closed captions, are useful for everyone.
Digital accessibility means making online content and services easy for everyone to use. This includes removing barriers to access, communication, and interaction that people face in the real world. Making content accessible isn't just about being inclusive; it makes information clearer and easier to understand for everyone.
[bookmark: _30j0zll]Diverse Abilities and Barriers
To commit to accessibility, we need to be aware of the barriers people face. While most people support the idea of inclusion, making real progress requires understanding the challenges faced by people with disabilities.
The following resources will help you learn how people with different abilities access and navigate digital content:
· Stories of Web Users
· How People with Disabilities Use the Web
· Overlapping Needs: People who are Elderly and People with Disabilities
[bookmark: _1fob9te]Laws and WCAG 
The Americans with Disabilities Act (ADA) is a civil rights law that protects people with disabilities from discrimination. The ADA applies to state and local government services, employers, and public places.
Section 508 is a law that requires federal agencies to make their electronic and information technology (EIT) accessible to people with disabilities. This means agencies must make sure employees with disabilities and the public can access information just like everyone else.
Web Content Accessibility Guidelines (WCAG) are rules that help make digital content easier to use for everyone. The WCAG guidelines have four main principles:
1. Perceivable: Users must be able to see or hear the information. It cannot be invisible to all their senses.
2. Operable: Users must be able to use the interface. It cannot require actions they cannot perform.
3. Understandable: Users must be able to understand the information and how to use the interface. It cannot be too confusing.
4. Robust: Users must be able to access the content with different technologies, including assistive technologies.
[bookmark: _3znysh7]Our Approach
At RM-PHTC, our commitment to equity, encompassing inclusive content, practices, environments, and opportunities, compels us to create accessible products. This commitment translates into a proactive approach to accessibility called "Shift Left'' which means thinking about accessibility throughout the design and development process, not just at the end. By integrating accessibility from the start, we can prevent issues and create a better user experience for everyone.
[bookmark: _2et92p0]Purpose and Layout
Accessibility begins in the design phase! 
This guide will help you design and create accessible content and is equally valuable for addressing accessibility issues later on (remediation). Crafting accessible content from the start is not only easier but also saves time compared to fixing them later. 
The guide is organized into sections for easy navigation and covers accessibility essentials and best practices. It also includes resources specific to different tools and platforms. There is an accessibility checklist linked at the end of the Accessibility Checkers and Tools section, which you can use as an auditing tool. This guide is not exhaustive and will be updated periodically.
[bookmark: _tyjcwt]Accessibility Essentials
[bookmark: _3dy6vkm]Section 1: Structure 
The structure of a page refers to how it's organized and laid out. It's like a framework that holds everything, including headings, paragraphs, lists, tables, images, and more. A well-structured page uses tags to show the order (hierarchy) and connections (relationships) between distinct parts, making it easy for everyone to use.
[bookmark: _1t3h5sf]Title and Headings
Descriptive titles and unique headings act like a roadmap, guiding users through the content. They make it easy to understand the structure and order of the page, which is especially helpful for people with cognitive disabilities.
Screen readers use heading levels to create an outline, so users can quickly move to different sections or skip parts of the content.
[image: ""]
Figure 1. An example showing heading levels and hierarchy in a section of a document - title, subtitle, heading 1, heading 2, and paragraph text.
Use the styles panel to apply the correct heading tags in the right order. This not only makes your content more accessible but also improves the overall user experience. It creates a clear table of contents and a user-friendly navigation pane. 
Best Practices
· Use the styles panel to apply headings. Avoid increasing font size, using color or bold text, or underlining text to give the appearance of headings. 
· Headings should clearly and accurately show how the sections of a page or document are organized.
· Titles and Headings should be concise, unique, and descriptive.
· Use only one top hierarchy element per web page or document.
· Use headings in hierarchical order (H1, H2, H3, H4, etc.) without skipping levels.
[bookmark: _4d34og8]Language and Landmarks
Set the language of a web page or document so that assistive technologies can get the information in the correct language.
When a passage or phrase in a document is in a different language than the main language of the document, it should be marked so that screen readers and other assistive technologies accurately read and pronounce the text. In documents, this can be done through specific settings in word processors or by using specific markup in HTML or PDF files.
Landmarks help users navigate a webpage. They act as signposts for different sections like the header, footer, main content, and navigation areas. Landmarks let users, especially those with screen readers, jump directly to specific parts of the page, making it easier to use.
While documents and presentations might not have explicit landmarks, similar principles to web content landmarks can help users navigate easily. Include consistent headers and footers for information like page numbers, document titles, or dates. Clearly define sections with headings and subheadings, making it easier for users to find and understand various parts of the content.
[bookmark: _2s8eyo1]Lists and Tables
When using lists and tables, identify and format them using the editor toolbar. Screen readers will announce structural elements making it easier for users to navigate the content.  
For lists, format them correctly so each item is separated. Use numbered lists for items that need to be in a specific order and use bullet points for items that don't need to be ordered. Use columns instead of tabs when presenting information in columns.
For tables, include meaningful header rows and columns to organize the content/data and show how it is related. Keep tables simple to make them easier for screen readers to manage. Also, include a table caption to provide context and improve understanding of the table's content. Avoid using tables solely for layout purposes, like creating columns. Well-structured content benefits everyone.
Best Practices
· Keep paragraphs short and use lists and bullet points to organize and help with understanding​. 
· Use tables for data only (unless a layout cannot be achieved otherwise)
· Avoid using spaces or tabs to present information in columns or format table data.
[bookmark: _17dp8vu]Section 2: Links and Navigation
A well-designed page or document should have a consistent layout and presentation of information. This helps users navigate quickly and easily from page to page. Inconsistent organization, especially in the placement and appearance of navigation elements, can be very frustrating for users who rely on assistive technologies like screen readers.
[bookmark: _3rdcrjn]Links
Effective links are self-explanatory and clearly show where users will go when selected. Non-descriptive link text can cause problems, especially for people who cannot quickly read the surrounding text. Users might click the wrong link or need to read the paragraph again to understand where the link leads. 
[image: ""]
Figure 2. An example showing link text should be meaningful and visually distinct to avoid confusion.
Link text should be unique and descriptive. Putting key terms at the beginning of the link phrase makes it easier for everyone to scan and understand. This also helps screen reader users, as the link text provides a clear path to the information they need. 
Using generic link phrases such as “Learn more” after a paragraph of text or "Click here" for links can be problematic - they are restrictive and non-descriptive. "Click here" links focus on using a mouse, ignoring other navigation methods like keyboard navigation, voice recognition, or tapping on mobile screens.
Links need to stand out from the surrounding text. Make links look different from regular text, so users don't have to guess. Typically, a combination of underlining and color is used to indicate hyperlinks. Using this same formatting to emphasize content makes it hard for users to differentiate between links and regular text. This is especially difficult for people with color perception impairments who may have trouble distinguishing certain colors or identifying links indicated only by color. 
All the rules for color contrast apply to links as well. Hyperlinks usually take on a blue color, but this can change with different themes. It's good practice to check if the link color contrast meets accessibility standards.
[image: ""]
Figure 3. The visual on the left is an example of good practice – the link text is unique and descriptive. The visual on the right shows two examples of what to avoid – the first example shows generic and non-descriptive link text that fails color contrast requirements. The second example shows the URL as the link text and visually looks like the surrounding text.
Best Practices
· Make sure links are distinct from other text. 
· Avoid using a combination of color and underlining to emphasize text that is not a link, as this can confuse users. 
· Link text should be descriptive and convey where the link is going. 
· Link text should make sense even when taken out of context because screen reader users might pull up a list of links on the page.
When creating content that includes links, the presentation should be tailored to how users will interact with the content—whether digitally, on paper, or in special cases like live webinars.
For digital content, such as documents, emails, or PDFs viewed online, it’s best to use descriptive link text such as "Learn more about the color contrast checker." and hyperlink the text instead of showing the full URL. Avoid using both bold and underline for non-link text, as this is reserved for links. Descriptive links improve accessibility by helping screen readers clearly communicate where a link leads, and enhance readability, allowing users to quickly understand the purpose of the link without needing to decipher long URLs.
For print content, such as documents distributed in a live presentation or as physical handouts, include the full URL. Since readers cannot click on a link in printed documents, providing the URL after the descriptive text (e.g., "Learn more about the color contrast checker at https://webaim.org/resources/contrastchecker/") ensures they have the necessary information to access the content later. This method maintains accessibility and usability in physical formats.
For live webinars or virtual presentations, where participants cannot directly click on links in slides, it’s a good idea to include the full URL on the slide for key resources (e.g., "Learn more about the color contrast checker: https://webaim.org/resources/contrastchecker/"). This allows participants to write down the link if they need it. For less critical links, use descriptive link text and mention verbally that the full URL will be shared in the chat or provided in a follow-up email or handout after the session. This approach keeps the slides clean while ensuring accessibility for both live and post webinar access.
[bookmark: _26in1rg]Keyboard Navigation
Navigation should not be restrictive—anything you can do with a mouse should also be possible with a keyboard. People who are blind, have low vision or have hand/wrist mobility limitations or paralysis may not use a mouse. Instead, they use their keyboard to navigate a web page or document. Users should always know their exact location on a page and be able to use the tab key to move smoothly and logically between sections.
To check this, try navigating the content using only the keyboard. Can you tell where you are on the page? Can you use the Tab key to go to the next header or topic and, Shift + Tab to go to the previous one? Can you use the Escape key to exit interactive components? Can you fill out and submit input fields and forms using only the keyboard?
[bookmark: _lnxbz9]Reading Order/Focus Order
The reading or focus order should be logical and intuitive, helping users understand the flow and interact with the content as intended, without confusion. This ensures that the visual presentation of content matches the order in which it is read by screen readers and navigated using the keyboard Tab key.
Incorrect reading order can cause frustration, making users miss information or struggle to navigate a page. It's essential to check and correct the reading order (where applicable) to create inclusive and accessible digital content for all users.
[bookmark: _35nkun2]Section 3: Visual Layout and Content Design
Eye-catching layouts and visuals are important for engaging users, but making sure the information is readable and understandable by everyone is crucial. White space plays a key role in design by helping to visually separate content and show relationships. Clear separation of content with margins, padding, and white space, and avoiding reliance solely on visual cues to convey meaning are important considerations for inclusive design.
[bookmark: _1ksv4uv]Images 
Alternative text (alt text) is important for people with visual or cognitive disabilities to understand images. It is a short description that tells them what the image shows. When a screen reader finds an image, it says it’s an image and reads the alt text. If images do not load because of slow internet or settings that block images, the alt text still describes them. If an image isn’t important or doesn’t add value, mark it as decorative so screen readers ignore it.
[image: ]
Figure 4. Example of an image with alt text. Alt text - a person sitting at a desk and using a computer.
Make the alt text short and to the point. Don’t include phrases such as “an image of” because screen readers already say it’s an image. Consider the context of the image when writing alt text, as it can change how people understand it. 
Keep alt text under one hundred characters since many screen readers cut off text at one hundred and twenty-five characters. For complex images like graphs and tables, include key information in the alt text and provide other formats to give extra details.
When writing alt text for a headshot, state that it’s a headshot, include the person’s full name and describe any relevant actions or important background details. Avoid over-describing the person’s appearance unless it’s essential to understanding the image or content.
When writing alt text for logos, mention that it’s a logo and include any text within the image. Use the format: “[Organization name] logo” to convey purpose and content to screen reader users. 
Alt text for functional images or icons should clearly describe what the icon does, like "Download PDF" or "Visit our Registration Page.”
For an infographic, alt text should include a short description, such as the title and type of information presented. Add a longer description with all essential information and text from the infographic as adjacent text on the page. 
To make charts and diagrams accessible, use a two-part text alternative. Include a short description in the alt text field to identify the image and its basic properties, like mentioning that a chart is a pie chart and the type of data it displays. Provide a long description with all essential information, either as a data table or detailed text. For data visualizations, use accessible data tables or include a link to spreadsheets, and for other diagrams, offer detailed text descriptions either as surrounding text or via a link.
If an image is a link, use alt text to explain where it leads. Don't use phrases like "Link to" or "Click to" because screen readers already say "link." Instead, describe what the link is for in the alt text. If the image is part of a link that has descriptive link text, mark the image as decorative. 
Best Practices
· Mark the image as decorative if it does not provide information or serve a purpose and is just used for layout or decoration.
· Alt text should explain how the image relates to the surrounding content, not just describe what the image shows.
· Limit alt text to below one hundred characters when possible.
· Do not include phrases like "image of ..." or "graphic of ...", etc. This would be redundant since screen readers already announce it along with the alt text.
[bookmark: _44sinio]Fonts
Choosing the right font is important for creating accessible content. Fonts with clear and distinct characters are essential for users with low vision or reading disabilities like dyslexia. Simple, sans-serif fonts like Arial or Helvetica are good choices for accessibility. 
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Figure 5. An example of Sans Serif (Lato) and Serif (Times New Roman) fonts.
[image: ]
Figure 6. An example of using too many font types.
Serif fonts have hooks at the ends of the letter strokes. While they look decorative, serifs can obscure the shapes of letters, making them run together. Fonts that are too thin, decorative, or have tightly packed letters can be hard to read.
Text size matters! Even accessible fonts are hard to read when they're too small. For web pages and documents where users can control zoom settings, a good practice is to use a typical font size of 12 points. This ensures readability for a wider audience and allows users with visual impairments who rely on screen magnification to customize their reading experience. 
Using too many different fonts can distract readers and make the content look busy and unprofessional. Use no more than two fonts in a document. Different styles (bold, italic) of the same font count as one. 
Bold colors for emphasis and highlights can make content stand out, but make sure there's good color contrast so the text remains easy to read. All the rules of color contrast apply here.
Avoid using all caps (unless needed), underlining (except for links), or distracting animations. They make reading harder. These can be especially important for people with attention or cognitive disabilities. Use visual styling carefully and minimize distractions to improve readability.
[image: ""]
Figure 7. An example of text in an image where text fails color contrast requirements.
For optimal accessibility, use actual text instead of images or pictures of text. Screen readers can't read text in images. Images can also be blurry or hard to read when zoomed in. If you must use images of text, ensure the text is large enough and has good contrast with the background to improve readability.
Best Practices
· Select simple, readable fonts (recommended to use sans serif fonts, for example, Arial, Helvetica, Verdana, etc.).
· For body text, use at least 12 points or around 16 pixels.
· Be consistent with fonts throughout the document or presentation (use no more than two font types and stay away from decorative fonts).
· Avoid blinking or moving text.
· Use the appropriate case. Sentence case is easier to read and feels more conversational. 
· Use real text rather than text embedded within images or graphics.
[bookmark: _2jxsxqh]Text Styles, Resize, Reflow, and Zoom
Many users, especially on mobile devices, adjust font size and zoom in for better viewing. This is similar to those using assistive technology for magnification and viewing content in a smaller window. Make sure the content adjusts smoothly without breaking when users change paragraph spacing, line spacing, word spacing, or letter spacing.
To keep the presentation of information consistent use text or paragraph styles instead of direct formatting. Avoid fully justified text; left-aligned text creates a clean, even layout that guides the reader’s eye and makes it easier to read.
Users should be able to zoom in on text up to 200% without losing content or functionality. While web browsers and word processors usually support this, some document creation methods might limit zooming. For example, fixed layouts with images in set positions might overlap with other content or become distorted when zoomed in. Test your content with different zoom levels and screen sizes to make sure it works well on different devices.
Best Practices
· Avoid blocks of fully-justified text. 
· Ensure content can adapt to different devices and viewports.
[bookmark: _z337ya]Color and Contrast
Use color thoughtfully and in moderation to avoid overwhelming users, especially those who are neurodivergent. 
Color can attract attention and guide users, but it's crucial to prioritize accessibility for people with visual impairments or color blindness. The readability of text and elements depends on the contrast between the foreground color and the background color. Low contrast can be a significant barrier, so avoid using shades that are too similar. 
Use online tools to check color choices for accessibility and aim for a contrast ratio of at least 4.5:1 between text and background colors. However, excessively high contrast can affect readability, particularly for users with dyslexia. 
Color should not be the only way to convey information. While color coding (like red for stop or incorrect) can be useful, users with visual impairments, color blindness, or those using screen readers might miss key details. Use alternative cues, such as icons, text labels, etc. alongside color to make sure everyone understands the meaning. Similarly, use clear and descriptive labels for interactive elements like links and menus so users can understand their function without relying solely on color.
[image: ""]
Figure 8. The visual on the left shows what to avoid. Here identical shapes in different colors are used to distinguish between correct and incorrect. The visual on the right shows an example of good practice. Here the wrong/cross icon and the check mark icon in different colors are used to distinguish between incorrect and correct.
[image: ""]
Figure 9. This is the same visual as the previous one but shown in grayscale, illustrating that people with vision impairments and color blindness will not get the needed information if color alone is used to convey meaning.
Best Practices
· Use an online color contrast checker such as the WebAIM color contrast tool to check for conformance. Follow the recommended contrast ratio - at least 4.5:1 for normal text and 3:1 for large text or icons. 
· Avoid light text on a light background or dark text on a dark background.
· Avoid using color as the only indicator of meaning or information. Use an additional element to convey information, such as shape differences or text labels.
[bookmark: _3j2qqm3]Readability
Readability is essential for people using assistive technology like screen readers and helps everyone understand information more easily. All accessibility strategies improve readability. 
Plain language, which is writing that is clear and easy to understand, is especially helpful for users with language barriers and cognitive challenges. Check spelling and grammar and avoid figures of speech, acronyms, and idioms. If you use acronyms, define them the first time they appear. Avoid jargon and complex expressions, keep paragraphs short, and use lists and bullet points for clarity. 
In a document, images can be either "inline" with the text or "floating" separately. Sighted users can see both types of images, but screen readers can miss floating images entirely. To ensure accessibility, make sure all images are inline so they can be detected by screen readers.
Be intentional with page layout by using descriptive headings, readable fonts, appropriate colors, and relevant multimedia. Ensure there is enough time for users to read and interact with content and use inclusive language so everyone feels represented and respected.
Writing content that is easy to understand and suited to your audience’s reading level is crucial. The WCAG guidelines recommend aiming for a reading level equivalent to lower secondary education.
Word has a built-in Readability Statistics tool that evaluates how easy your document is to read. It provides information such as the average number of sentences per paragraph and the percentage of sentences written in passive voice. 
To open this tool, go to the Review tab, select the Editor tool, and then choose “Document stats”. The readability results are divided into three sections: counts, averages, and readability.
In the averages section, pay attention to the length of your paragraphs and sentences. If your paragraphs contain more than five sentences, consider breaking them into shorter, more manageable sections. Similarly, if your sentences exceed twenty words, try shortening them or splitting them into two to improve clarity.
The readability section includes three key measures: Flesch Reading Ease, Flesch-Kincaid Grade Level, and Passive Sentences. The first two are readability tests designed to assess the clarity and complexity of English texts. The Flesch Reading Ease score ranges from 0 to 100, with higher scores indicating easier readability. If your score is below 50, review the content and simplify it. The Flesch-Kincaid Grade Level reflects the U.S. grade level needed to understand the text. If your score is higher than 8, consider revising the content to make it easier to read. Lastly, if more than 20% of your sentences are written in passive voice, revise them into active voice to create clearer, more direct writing. Active voice connects the subject directly to the action, making sentences more engaging.
Please note that some documents may show a higher grade level due to factors such as the use of unfamiliar topics, math concepts, technical language, and/or abstract concepts, which typically result in a higher grade level requirement for comprehension. 
[image: ""]
Figure 10. Readability Statistics panel in Word
Another free useful tool for checking readability is the Hemingway Editor. You can paste your text into the app, and it will highlight areas for improvement. As you make changes, the app updates the readability score in real time.
Best Practices
· Use plain language​ appropriate for the content and audience. Use a readability checker such as Word’s Readability Statistics tool or the Hemingway Editor. 
· Avoid jargon and complex figures of speech.
· Define acronyms on first use.
Resource
Reading Level: Understanding Success Criterion SC) 3.1.5
[bookmark: _1y810tw]Section 4: Multimedia, Animations, and Motion
[bookmark: _4i7ojhp]Audio and Video
People who cannot access information through audio or video alone should still be able to understand the content by accessing alternatives for pre-recorded and live media. 
Adding a transcript (text version of the audio content) for pre-recorded audio helps those with hearing impairments and anyone who struggles with understanding spoken language or regional accents. Transcripts are also beneficial for those who prefer reading over listening because they read faster than people speak. 
Including closed captions (synchronized text that appears on the screen alongside the video) in pre-recorded videos offers similar benefits, reinforcing content and assisting non-native speakers. While automatic captioning tools, like YouTube’s auto-generated captions, can capture much of the dialogue, they should be reviewed for spelling, punctuation, and grammar accuracy. WCAG requires captions to have 99% accuracy. For live audio and video, such as webinars, provide real-time captioning. 
Users should be able to pause or stop any media that plays automatically and use any accessibility features available in the media player.
Best Practices
· Provide a transcript for audio clips.
· Provide closed captions for videos.
· Give users the ability to stop, pause, and use the accessibility features available with the player.
[bookmark: _2xcytpi]Animations and Timed Content
Automatic movement can cause vertigo, headaches, and nausea in people with vestibular disorders and seizures in those with photosensitive epilepsy. It can also be distracting for people with learning and cognitive disorders.
Users must have a way to pause, stop, or hide any content that begins playing or moving automatically and lasts 5 seconds or more. This applies to animations, object transitions, animated gifs, parallax scrolling, and moving elements created with code such as data visualizations.
Avoid flashing content that flashes more than 3 times per second. Animated gifs are accessible if they stop playing after 5 seconds, users can pause or stop them (if longer than 5 seconds), and there is good alternative text describing the gif. The animation should not have rapid blinking or flashing, and any text in the gif should have good color contrast with the background. Consider using a still image instead, or provide an alternative way to access the information, like an embedded video. Use the Photosensitive Epilepsy Analysis Tool to ensure the gif will not trigger seizures in people sensitive to flashing.
For timed content, ensure users can adjust or extend any time limits so people with cognitive or mobility impairments can complete tasks without feeling rushed. When possible, avoid time limits altogether to let users interact at their own pace.
[bookmark: _1ci93xb]Section 5: Accessibility Checkers and Tools
· WebAIM: Color Contrast Checker 
· TPGI: Color Contrast Analyzer 
· WebAIM: Link Contrast Checker
· Venngage: Color Blind Simulator
· Hemingway Editor: Readability
· Designing for Accessibility - Posters set
· Photosensitive Epilepsy Analysis Tool
· Accessibility Checklist
[bookmark: _3whwml4]Email, Documents, Presentations, and PDF
Microsoft products include a built-in Accessibility Checker that can stay open while you work (this is the best option for efficiency) or you can open it later to check your final draft. 
Automated tools like the checker cannot catch all accessibility issues, so some need manual checking:
· Color reliance: Avoid using color alone for meaning. For example, colorblind users may struggle to distinguish inline replies in different colors.
· Structure: Ensure proper styles are used for headings, bullet points, and table headers. Check and correct reading order where applicable.
· Links: Use clear descriptive link text and avoid using both bold and underline for non-link text, as this is reserved for links.
· Alternative text: The Accessibility Checker flags missing or auto-generated alt text but can’t verify its accuracy, so these need to be reviewed.
[bookmark: _f0oqxv3k2up4]Outlook
To turn on the Accessibility Checker in Outlook, compose a new email, go to the Options tab, and select the “Check Accessibility” icon. In the Accessibility pane, you'll see the inspection results along with recommendations for fixing errors and warnings.
[image: ""]
Figure 11. Accessibility Checker in Outlook
Best Practices
· Use sans serif fonts in at least 12-point size for better readability.
· Add alt text to all images (including screenshots describing important steps or details).
· Use the "Attach File" option for attachments instead of dragging files into the email body.
· Apply built-in styles like headings and lists to improve structure and readability.
· Use clear, meaningful text for hyperlinks, and ensure linked content (videos, PDFs) is accessible.
· Avoid extra spaces or tabs, as screen readers may repeatedly say "blank"; use formatting like indents for white space.
· Ensure good color contrast and use a white background for emails to avoid loading issues or blocking alt text.
· Write in plain language, with key information first, and use an active voice.
· Make email signatures accessible by using plain text for contact details and alt text for logos. Avoid using tables for formatting your signature.
Resource
· Improve accessibility with the Accessibility Checker
[bookmark: _2bn6wsx]Word and PowerPoint
Run the built-in accessibility checkers. Accessibility results are divided into errors and warnings. Errors must be corrected, while warnings should be reviewed and fixed only if needed. To address an issue, first select it from the Accessibility Checker and then follow the suggested steps to resolve it.
Before exporting documents and slides to different formats, check that they are accessible. After exporting, review the files, like PDFs, to ensure they are still accessible.
Resources
· WebAIM: Word Accessibility
· Microsoft: Word Accessibility
· WebAIM: PowerPoint Accessibility
· Microsoft: PowerPoint Accessibility
· WebAIM: Word and Powerpoint Accessibility Evaluation Guide
[bookmark: _qsh70q]Google Docs and Slides
When creating a document or presentation, you want to ensure it’s accessible to everyone. If you're using Microsoft products like Word or PowerPoint, the built-in Accessibility Checker is there to guide you along the way. It works quietly in the background, catching issues and offering suggestions to ensure that your content meets accessibility standards.

But what if you’re collaborating in Google Docs or Slides? In this case, you need to manually follow accessibility best practices—such as using proper heading styles, adding alt text to images, and ensuring readable fonts and clear color contrast. 
When using Slide templates, make initial accessibility changes directly in the Master Slides (for Google Slides - go to the Slide tab, and select “Edit Theme”). Here are some key points to consider:
· Choose Accessible Fonts and Sizes: Use sans-serif fonts (like Arial or Verdana) and ensure the text is sized at least 18-24 points for better readability.
· Apply Proper Heading Styles: Adjust the heading hierarchy in the Master Slide to enhance the structure and facilitate easier navigation for screen readers.
· Ensure High Color Contrast: Modify color combinations to provide sufficient contrast between text and background, improving readability.
· Add Alt Text to Master Images: If the template includes images, shapes, or logos in the Master Slide, add descriptive alt text as needed.
As you update the placeholders, make sure they are accessible. For example, add descriptive alt text to needed images inserted in image placeholders. Implementing these changes establishes a solid, accessible foundation for the entire presentation, saving time and enhancing usability.
When the content is ready, a good practice is to download the content into PowerPoint or Word and run the built-in Accessibility Checker. This step helps catch any errors you may have missed and ensures your final content is fully accessible before sharing it with others.
Resource
· Google Docs and Slides Accessibility
[bookmark: _3as4poj]Creating PDFs
Microsoft Office documents and presentations can retain accessibility features when converted to PDF, but they still need to be checked in Acrobat Pro after conversion.
If a PDF is untagged or has incomplete tags, it’s usually best to return to the original source document, fix the accessibility issues, and re-create the PDF. If the original file isn’t available, you can use Acrobat Pro to convert the PDF back into a Word or PowerPoint file. To do this, open Acrobat Pro, select File > Export To, and choose the format you need. After making the necessary accessibility changes, export it again as a PDF.
There are three ways to create PDFs from within Word or PowerPoint:
· Using the Acrobat tab
· Save As PDF
· Print to PDF
The Print to PDF option should never be used if the document needs to be accessible. This method strips away structural information, preserving only the text and images, making the PDF inaccessible.
You can also create a PDF by selecting File > Save As. In the Save As menu, choose PDF (*.pdf) from the file type options and save. This should create a tagged PDF by default. Before saving, select Options and ensure the box for "Document structure tags for accessibility" is checked. However, some accessibility information may not present correctly, and these PDFs need additional steps to review and fix.
When Acrobat Pro is installed, it adds an Acrobat tab to Word and PowerPoint. To create a PDF, go to this tab and select Create PDF. PDFs created through the Acrobat tab should automatically include tags. If they don’t, select Preferences under the Acrobat tab and ensure the box for "Enable Accessibility and Reflow with tagged Adobe PDF" is checked. PDFs created with this approach are more compatible with Acrobat programs, offering better control over accessibility tags and easier editing of these tags after creation, making this the preferred method for optimizing content for accessibility.
[image: ""]
Figure 12. The Acrobat tab and Create PDF option in Word.
[image: ""]
Figure 13. Ensuring "Enable Accessibility and Reflow with tagged Adobe PDF" is checked. 
Resources:
· Create accessible PDFs with Microsoft 365 apps 
· PDF accessibility (Acrobat Pro)
· WebAIM: PDF Accessibility
· Converting Documents to PDFs
[bookmark: _1pxezwc]Canva
· Canva Design Accessibility
· Canva PDF Accessibility
· Accessibility features in Canva
[bookmark: _casbzboecim7]Beginning your accessibility journey
Improving accessibility can seem like a daunting task, especially when there are many digital assets to review and update. However, creating an inclusive environment is essential, and success requires a collective effort from everyone. 
Whether you're starting small or tackling larger projects, breaking the process into manageable steps ensures progress is made. By prioritizing key tasks and committing to continuous improvement, the journey to accessible content becomes more achievable and impactful.
Here’s what you can do now with the tools and information you already have:
1. Understanding the Basics of Accessibility: Learn the accessibility essentials and how they can enhance the user experience for everyone. Familiarize yourself with relevant best practices and understand how to implement these in the various programs you use. Continuous education is crucial for staying updated on accessibility standards and ensuring ongoing improvements in your digital content.
2. Starting with your sphere of influence: Begin by making changes within your immediate control. Focus on enhancing accessibility in the documents, presentations, and digital content that you create or manage.
3. Inventory digital assets: Create a comprehensive list of all your digital content (those that you create or manage) per project, including documents, presentations, and media. This will help you identify which items need to be reviewed and updated for accessibility.
4. Prioritizing assets: Focus first on public-facing materials such as communications, marketing content, documents, presentations, and PDFs. Start with the assets that are most frequently used, as making those accessible will have the greatest impact.
5. Prioritizing tasks: Assess which accessibility tasks can be managed based on your skills and available resources. Identify tasks that will require more time for the work and plan accordingly. For tasks beyond your capacity, allocate time for self-education or seek partnerships and help for accessibility remediation. There are many resources available that can provide remediation guidance. Depending on the identified tasks and timeline – identify external assets and allocate time and efforts to reach out to external sources or partners for remediation.
6. Documentation and evaluation: Keep a record of your accessibility efforts. This documentation helps track improvements and demonstrates your commitment to making digital content accessible for all users.
Here’s a simple Accessibility Audit Worksheet to help you get started and document your efforts. You can make a copy and modify it according to your project requirements.
[bookmark: _49x2ik5]Meetings and Events
[bookmark: _2p2csry]Virtual
Before your meeting or presentation, reach out to participants to ask participants if they have any accessibility needs. This helps you plan so everyone can participate comfortably. Even if no specific requests come in, have alternative formats ready.
For presentations using documents like PowerPoint, Excel, or Word, make them accessible and share these versions with participants ahead of time. For slides with lots of graphics, provide a plain text version. This helps participants who use assistive technologies, like screen readers, or those with low vision, to prepare in advance. For example, if you share presentation notes ahead of time, a Braille user can prepare and follow along better than trying to keep up with both a speaker and a screen reader.
If you update the presentation materials after sending them out, make sure to send the updated versions to avoid any confusion.
If the presentation is live, make sure automatic captions are enabled. For recorded presentations, create accessible versions of the recording by adding captions and providing a transcript.
Resource:
· Tips for Accessible Screen Sharing
[bookmark: _147n2zr]In-person
· Guidelines for Creating Accessible Meetings and Events 
Additional Tools
[bookmark: _s63netwz3qc9]SensusAccess 
SensusAccess is a web-based tool that helps convert inaccessible files into accessible formats. It is designed as a “just-in-time” self-service solution that provides automated file conversion services. The conversion process may not make a document fully accessible, so always manually review the remediated content for accuracy. The quality of the file you receive after conversion depends on the quality of the original file.
What does SensusAccess do?
· Accessibility conversions: Convert image and image-based PDF files to text-based documents (Word, HTML, text-based PDFs, etc.)
· Audio services: Files can be converted into plain MP3 files as well as DAISY (accessible audio) format. 
· E-book services: Documents can be converted into EPUB, EPUB3, EPUB3 with media overlays, and MOBI (Amazon Kindle) e-book formats.
· Braille services: Documents can be converted to and from contracted and uncontracted braille.
The SensusAccess e-learning course will help you understand how to convert material into alternate or accessible formats.
Resource:
· SensusAccess Guides and Best Practices
[bookmark: _s3axgpkzgrqc]AI Tools
All content generated by AI tools should be reviewed and verified before being finalized. This helps ensure accuracy and quality, as AI-generated content can sometimes have errors or overlook important details. Human review is essential to ensure the final product meets the necessary level of accuracy and reliability.
· Alt image description utility - This tool uses ChatGPT to analyze uploaded images and create detailed alternative text descriptions. It can recognize and extract text that is embedded in images. You can also add additional details or context about the image. Follow best practices and keep alt text under one hundred characters since many screen readers cut off text at one hundred and twenty-five characters.
· Ask Microsoft Accessibility - This tool helps users create accessible content by providing information about the accessibility of Microsoft products and services. You can type a question such as, "Missing Slide Title in PowerPoint: How can I add a slide title? or “How can I make my Excel sheet more inclusive?" and the AI assistant will quickly list several solutions and related resources. It only uses information from microsoft.com and does not answer general accessibility or coding questions. 
[bookmark: _3o7alnk]Learning Resources
· A Web for Everyone
· Digital Accessibility Foundations (W3C)
· Learning Path: Accessibility for Content Contributors
· Learning Path: Accessibility for Designers
· Create Accessible Digital Products
· Digital Accessibility Workshop (CO Empathy Lab)
· Disability Language Style Guide
· CU Anschutz Digital Accessibility Website and Resources


Revised Oct 2024		Page 1

image2.png
Heading 1

Paragraph

Heading 2

Paragraph

deas

Typography Best Practices for
the Modern Web

A guide to responsive web typography covering all the best
practices & font styling size rules to ensure your site's
content is readable & a joy to behold.

Establishing a Visual Hierarchy

The most important objectve of 890 web typography i to create a hierarchy of content that isually
flows from one element to the next. Proper distincton between your Headings, Subheadings and Body.
text.  variety of font welghts and styes. and having enough white space between blocks of textare al
factors that promote an effotiess reading experience.

Building a Strong Body

Your first order of business s to nalldown your ste's main Body tex,since this i what your visitors will
spend most of ther time reading. Your goal s to create text that flows naturally across large
parasraphs. insoiring a healthy thythm for lons tretches of reading.





image3.png
Link Appearance
Links should look like links and nothing else should. Users

may get frustrated if they try to click on textual phrases or
graphics that look like links but are not. They will also be
frustrated if they must move their mouse all over the page
trying to discover links that do not look like links.




image4.png
& Do € Don't

For further details, visit Click here for details.
WebAIM'’s article on
links. https://webaim.org/techn

igues/hypertext/link text





image5.png




image6.png
Aa Bb Cc Dd

Sans Serif

Aa Bb Cc Dd
Serif




image7.png
NEVER USE TOO MANY
FONT TYPES!
It will make the content
look messy and cluttered.




image8.png




image9.png
‘ Incorrect Q Incorrect

‘ Correct Q Correct




image10.png
‘ Incorrect Q Incorrect

‘ Correct Q Correct




image11.png
prewepw—— x Incusiveness .
Punctuaion Convntions 3
Resume "
Sensie Geopolticl Refrences

Vocabulry '

Similrty
e, i should ncude all of

Checkfor ity o anine
” “

what you wousd say. Remember Check

Joud gves you: e for good fow

Gesgrers v senve s e naraor ey . prowsSionas). They may reach out 0 you

Iunciaon o  hey have suggestonsfor wording changes o hfp e naratve o -

you nomally do during th deleryof s content, descibe them and provide detals abou | 1nights
fonal designers are wel versed I ifrent Va3 o provide acihtes andcan deterine

your desied outcomes i the onine space. Document ats





image12.png
View Help Message Inset  Formattext  Draw

B[] showsee ShowCe  [~] Show From

> Favorites. Drafts % o p—
v v Today
Folders R
& Inbox 808 [ [Oraft] Sheena Mammarappali





image13.png
@ osme

File  Home

£
Create]
POF

preferences.

Creste Adobe O

Overview

B2 O~

Insert  Draw Design

T

Create PDF and Ml
Share via Outlook Merge

Crese andshare

B

Grant Budgeting Asynch Scipt + Saved to this PC

Llayout References Mailings Review View
- o= -
& & &
ClemePOF  Acobat Create POF ana
and Share ik Comments~ | Run Action

Review nd Commert_ Create and Run Acion

e s

£ search

Developer.





image14.png
Y -
Gonerorana Mot Gronesr  pcoow
o Shre v Oulook Mg 4 Stk Comments -
e vt snen R conmt < S sncmy e
ol SEKNEEY KT RKET EIENTEEE] Porsrseas
e oo e St =

Ut s e b v iP5 cmr sl
Tk of i script s the ecord of how you would defver e e
Wwoul say i you were presentng. Bksteror wat
« Imagine yoursel ghing that talk nfon of a r0up of pe Borstcaio 0 S
general peopie wi b hearing (1ol 1ading) Your words, 0| @ CammOocammcn

« Oneofournsructonaldesigners wilserve as e narator|  POrACoscs tore
Questons about pronunciaton - o ey have SUGQESLONS | gptcsen s

= Hyou have aciles you nomal do uring he delery of
outcomes. Out nsiuctonaldesigners are well versed n
approprateway toacheve yourdesied outcomes i the.

. Tips for Writing Your Script

'+ Use a conversational tone.





image1.png
Rocky Mountain Public Health Training Center

&) A Member of the Public Health Learning Network




